Thank you very much for using the QE for AFE V2.0.0.

This release note covers product installation, restrictions, and so on. Please read this document before using the product.

Contents

1. About QE for AFE
   1.1 Summary
   1.2 Functions
   1.3 New Functions
   1.3.1 Release QE for AFE e² studio plug-in
   1.3.2 Support emulator connection
   1.3.3 Improve some functions on configuration diagram
   1.4 Supported Environment
   1.5 Supported Microcontrollers

2. Installation and Uninstallation
   2.1 Installing This Product
   2.1.1 Install from the “Renesas Software Installer” menu of e² studio
   2.1.2 Install using QE (zip file) downloaded from the Renesas website
   2.2 Updating This Product
   2.3 Uninstalling This Product
   2.3.1 Uninstall Plugin Version
   2.3.2 Uninstall Standalone Version

3. Notes / Restrictions
   3.1 Usage Considerations
   3.1.1 Notes on configuring ADC16 sampling time
   3.1.2 Notes on configuring SDADC24 and ADC16
   3.1.3 Notes on X-Axis Time Width setting on [Monitor] view
   3.1.4 Notes on clicking [Write Value to The Target Board] button after configuring one AFE component setting
   3.1.5 Notes on ADC16 One-shot and Auto mode selection on [Monitor] View
   3.1.6 Notes on closing [AFE Monitor (QE)] view
   3.1.7 Notes on UART connection after evaluation board reset
   3.1.8 Notes on monitor multiple channels data
   3.1.9 Notes on OPAMP trimming function failed using emulator
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1.10</td>
<td>Notes on downloading AFE adjustment project</td>
<td>10</td>
</tr>
<tr>
<td>3.1.11</td>
<td>Notes on pressing [Stop AFE Tuning] button</td>
<td>10</td>
</tr>
<tr>
<td>3.2</td>
<td>Functional Restrictions</td>
<td>11</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Restrictions on showing a video about how to use QE AFE</td>
<td>11</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Restrictions on ACMPLP configuration.</td>
<td>11</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Restrictions on abnormal phenomena in AFE tuning operation</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Revision History</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Notice</td>
<td>1</td>
</tr>
</tbody>
</table>
1. About QE for AFE

1.1 Summary
QE for AFE is an evaluation tool for embedded system development that performs graphical tuning with an integrated analog front end (AFE). Using this tool, you can configure AFE registers, write register into evaluation board and monitor the AFE tuning results in a waveform.

1.2 Functions
The main functions are listed below:
1. Connect and operate the evaluation board
2. Config AFE related registers with GUI
3. Display graphics of the AFE tuning results and digital filter frequency response
4. Interact with FSP property and generate code by FSP when working as one of e² studio plug-in,

1.3 New Functions
1.3.1 Release QE for AFE e² studio plug-in
From QE for AFE V2.0.0, you can use QE for AFE in e² studio, which can interact with FSP property and generate code by FSP configuration.

1.3.2 Support emulator connection
From QE for AFE V2.0.0, when work as e² studio plug-in, you can tune AFE by emulator connection with evaluation board.

1.3.3 Improve some functions on configuration diagram
From QE for AFE V2.0.0, the following functions are improved:

- ADC16 sampling time selection is changed to an editable combo box with the maximum and minimum sampling time. User can select directly, also can enter any other value within the range manually.

![Figure 1-1. ADC16 sampling time selection](image.png)
• SINC3 filter setting is moved to a pop-up dialog, which is open by clicking “Config” button on SDADC24 configuration diagram.

![Figure 1-2. SINC3 filter setting](image)

• AVCC0 and DAC output voltage value are displayed on DAC8 and DAC12 GUI.

![Figure 1-3. AVCC0 and DAC output voltage value](image)

• ADC16 calibration function is performed on all A/D channels once.

![Figure 1-4. ADC16 calibration function](image)
1.4 Supported Environment

- Windows10 (64 bit)
- Renesas e2 studio 2022-01
- RA Flexible Software Package (FSP) v3.6
- Evaluation board: EK-RA2A1
- RA2A1 Group Board Control Program for "QE for AFE" in application note R01AN5795EJ0200

1.5 Supported Microcontrollers

- RA Family (only MCUs that incorporate the AFE)
  - RA2A Series: RA2A1
2. Installation and Uninstallation

2.1 Installing This Product

Use either of the following procedures to install this product.

2.1.1 Install from the "Renesas Software Installer" menu of e2 studio

1. Start e² studio.
2. Select the “Renewas Views” - “Renesas Software Installer” menu of e² studio to open the “Renesas Software Installer” dialog box.
3. Select the “Renewas QE” and click the “Next >” button.
4. Select the “QE for AFE (v2.0.0)” check box and click the “Finish” button.
5. Check that the “QE for AFE” check box is selected in the “Install” dialog box and click the “Next >” button.
6. Check that the “QE for AFE” check box is selected as the target of installation and click the “Next >” button.
7. Check the “Renesas QE for AFE” check box and click the “Finish” button.
8. After confirming the license agreements, if you agree to the license, select the “I accept the terms of the license agreements” radio button, and click the “Finish” button.
9. When the dialog box for selecting a trusted certificate appears, check the displayed certificate, and then click on the “Trust Selected” button to continue installation.
10. Restart the e² studio by following the instructions on the screen.
11. Start this product from the “Renewas Views” - “Renesas QE” menu of e² studio. For details about how to use this product, see the “Help” menu of e² studio.

2.1.2 Install using QE (zip file) downloaded from the Renesas website

A downloaded zip file has both a plugin version and a standalone version.

2.1.2.1 Install Plugin Version

1. Extract the downloaded zip file.
2. Start the e² studio.
3. Click on “Help”, and then click on the “Install New Software...” menu item to open the “Install” dialog box.
4. Click on the “Add...” button to open the “Add Repository” dialog box.
5. Click on the “Archive...” button, select the installation file (zip file under the QE-AFE folder) in the opened file selection dialog box, and then click on the “Open” button.
6. Click on the “Add” button in the “Add Repository” dialog box.
7. Expand the “Renewas QE” item shown in the “Install” dialog box, select the “QE for AFE” check box, and then click on the “Next >” button.
   * If you check off the “Contact all update sites during install to find required software” checkbox, you can shorten the installation time.
8. Confirm that the installation target is “QE for AFE”, and then click on the “Next >” button.
9. After checking the license, select the “I accept the terms of the license agreements” radio button if you agree to it, and then click on the “Finish” button.
10. When the dialog box for selecting a trusted certificate appears, check the displayed certificate, and then click on the “Trust Selected” button to continue installation.
11. Restart the e² studio by following the instructions on the screen.
12. Start this product from the “Renewas Views” - “Renesas QE” menu of the e² studio. For details about how to use this product, see the “Help” menu of e² studio.
2.1.2.2 Install Standalone Version

1. Extract ".zip" file to a user-specified location on the PC.
   Note: Please do not put the tool under OS program folder (C:\Program Files)
2. Start this product by double clicking "\QE-AFE\eclipse\qe-afe.exe".
3. For the first time this product starts, there is a dialog of license agreement. After checking the license, you can select “Agree” or “Disagree”.

![License Agreement Dialog](image)

Figure 2-1. License agreement dialog

4. If “Agree” is selected in above step, the product is launched then you can use it; if “Disagree” is selected in above step, the product won’t be launched.

2.2 Updating This Product

If you have already used this product, you can update it in the same way as the procedure for installation.

2.3 Uninstalling This Product

2.3.1 Uninstall Plugin Version

1. Start the e2 studio.
2. Select “Help -> About e2 studio” to open the “About e2 studio” dialog box.
3. Click the “Installation Details” button to open the “e2 studio Installation Details” dialog box.
4. Select “Renesas QE for AFE” displayed on the “Installed Software” tabbed page and click on the “Uninstall...” button to open the “Uninstall” dialog box.
5. Check the displayed information and click on the “Finish” button.
6. Restart the e2 studio by following the instructions on the screen.

2.3.2 Uninstall Standalone Version

Delete the entire folder which .zip package is extracted.
3. Notes / Restrictions

3.1 Usage Considerations

Please pay attention to the following items.

3.1.1 Notes on configuring ADC16 sampling time

The sampling time of ADC16 is limited by the PCLKB/PCLKD clock setting. For different PCLKB/PCLKD clock, you should set sampling time within the special range. Otherwise, ADC16 tuning can't perform successfully. The detailed information can be found in “RA2A1 Group Board Control Program for “QE for AFE” application note.

3.1.2 Notes on configuring SDADC24 and ADC16

SDADC24 and ADC16 source clock is got from the firmware running on the evaluation board, please connect with evaluation board before configuring SDADC24 and ADC16.

3.1.3 Notes on X-Axis Time Width setting on [Monitor] view

To display a waveform by clicking “Read AFE tuning data from file”, X-Axis Time Width setting should not be too large. As a recommendation, X-Axis Time Width should be set no more than 10s with maximum SPS 15625.

![Figure 3-1 X-Axis Time Width setting](image)

3.1.4 Notes on clicking [Write Value to The Target Board] button after configuring one AFE component setting

It is recommended to click [Write Value to The Target Board] button each time completing one AFE component configuration and move to next AFE component configuration. The reason is that firmware will check the validity of the register value basing on the register value on the evaluation board. Keeping the register values on the evaluation board always consistent with the GUI configuration can avoid unexpected errors when writing new registers value to the evaluation board.

3.1.5 Notes on ADC16 One-shot and Auto mode selection on [Monitor] View

ADC16 has 2 tuning modes: One-shot and Auto. The waveform of these 2 modes is depending on ADC16 sampling time setting:

- When ADC16 sampling time is short (performing high-speed conversion)
  - One-shot mode: QE for AFE reads data from evaluation board and draws the waveform only once
  - Auto mode: QE for AFE reads data from evaluation board and draws the waveform continuously

- When ADC16 sampling time is long (performing low-speed conversion)
  - Either One-shot mode or Auto mode, the waveform are same: QE for AFE reads data from evaluation board and draws the waveform continuously

3.1.6 Notes on closing [AFE Monitor (QE)] view

- In standalone version, while tuning is in progress and close monitor view, the tuning is stopped automatically.

- In e² studio plugin version, if several perspectives exist, and one [AFE Monitor (QE)] monitor view is closed while tuning is in progress, the tuning won't be stopped. You can still observe the tuning result in other perspective. Until the last monitor view is closed, the tuning is stopped automatically.
3.1.7  **Notes on UART connection after evaluation board reset**
After reset of the evaluation board, please take note to set bitrate as 1,000,000 bps (default bitrate), then click "connect" button to set up connection.

3.1.8  **Notes on monitor multiple channels data**
When monitoring multiple channels data, usually the data quantity of each channel should be same. If you see the data quantity is not same, it means certain channel data is invalid and was discarded when drawing waveform. QE for AFE V2.0.0 doesn't output any message for invalid data. So please kindly take note about it.

![Multiple channel waveform](image)

**Figure 3-2 Multiple channel waveform**

3.1.9  **Notes on OPAMP trimming function failed using emulator**
When using emulator, OPAMP trimming function occasionally fails. The phenom is that even click "Next" and wait a while on Step1 or Step2, the wizard can't move to next step. So to execute OPAMP trimming function, please take priority to use USB or UART connection mode.
3.1.10 Notes on downloading AFE adjustment project
To download AFE adjustment project, please kindly take note to set the region using the following steps. Otherwise, project can’t be downloaded.

1) Select [Window] > [Show View]>[Smart Browser] menu.
2) Select [Setting] in the Smart Browser [View menu].
3) Select one region in the settings dialog and click [Apply and Close] button.

![Figure 3-3 Smart Browser Region setting](image)

3.1.11 Notes on pressing [Stop AFE Tuning] button
User presses [Stop AFE Tuning] button, then the waveform doesn’t stop and an error message output in [Console] view as the following image. If you met this case, please try to press [Stop AFE Tuning] button again. By this way, usually tuning can stop correctly without reset the board.

![Figure 3-4 Stop Failed Case](image)
3.2 Functional Restrictions
The following restrictions apply to QE for AFE[RA] V2.0.0. These restrictions will be solved in next or future version.

3.2.1 Restrictions on showing a video about how to use QE AFE
The video is not ready for publish, so you can't open the video even if you press the video button.

[Workaround]
Please wait for video content publish.

3.2.2 Restrictions on ACMPLP configuration.
- “DAC8 channel 0 output” is selected as ACMPLP0 input (refer to figure3-4 (1))
  - When switcher (A) selects Vref (refer to figure3-4 (A))
  - When ACMPLP0 is disabled (refer to figure3-4 (D))
  - When switcher (B) selects IVREF0, switcher (C) selects Vref (refer to figure3-4 (B) and (C)) and ACMPLP1 is enabled (figure3-4 (E) selects “Enable”)

Either of above ACMPLP0 settings will cause the register value cannot be successfully written to the EK-RA2A1 board with the following 1) – 3) settings.
1) Set P013 as DA8_0 function in DAC8 page, P013PFS = 0A018000 can't be write to test board successfully.

   ![Figure 3-7 DA8_0 example setting](image)

2) Select DA8_0 as OPAMP1 input in OPAMP page, AMP1PS = 80 can't be write to test board successfully.

   ![Figure 3-8 OPAMP example setting](image)

3) Select “DAC8 channel 0 output” as input in ACMPHS page, CMPSEL1 = 08 can't be write to test board successfully.

   ![Figure 3-9 ACMPHS example setting](image)

[Workaround]
In above ACMPLP0 setting, (1) setting is invalid. So please change (1) from “DAC8 channel 0 output” to “CMPREF0”.

- “DAC8 channel 1 output” is selected as ACMPLP1 input (refer to figure3-4 (2))
  - When switcher (B) selects IVREF0 (refer to figure3-4 (B))
  - When switcher (C) selects Vref (refer to figure3-4 (C))
  - When ACMPLP1 is disabled (refer to figure3-4 (E))

Either of above ACMPLP1 settings will cause the same limitations 1) and 2) as selecting” DAC8 channel 0 output “above.
[Workaround]
In above ACMPLP1 setting, (2) setting is invalid. So please change (2) from “DAC8 channel 1 output” to “CMPREF1”.

3.2.3 Restrictions on abnormal phenomena in AFE tuning operation

When the following abnormal phenomena occur, it indicates that the data got from evaluation board has some errors under the current AFE configuration.

(1) After a period of tuning operation, the waveform stops without any error message output in [Console] view.

(2) User clicks “Stop AFE Tuning” button, then the waveform seems stopped but an error message output in [Console] view as the following image.

![Figure 3-10 “Stop AFE Tuning” error message](image)

[Workaround]

Please refer to recommended parameters setting in Board Control Program for “QE for AFE” application note.
## Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Page</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>Mar.31.22</td>
<td>-</td>
<td>First edition issued.</td>
</tr>
</tbody>
</table>
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
   A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
   The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is specified.

3. Input of signal during power-off state
   Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
   Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.

5. Clock signals
   After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
   Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between \( V_{IL} \text{ (Max.)} \) and \( V_{IH} \text{ (Min.)} \) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in the transition period when the input level passes through the area between \( V_{IL} \text{ (Max.)} \) and \( V_{IH} \text{ (Min.)} \).

7. Prohibition of access to reserved addresses
   Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
   Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of such circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such unauthorized alterations, copies, or reverse engineering.

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”. The intended applications for these grades: “Standard” and “High Quality”.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to, unauthorized access to or use of a Renesas Electronics product or any system that uses a Renesas Electronics product. RENESAS ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS PRODUCTS WILL BE INNUVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.); may cause serious property damage (space systems; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. If it is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note2) “Renesas Electronics product(s)” mean any product developed or manufactured by or for Renesas Electronics.

Contact Information

For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit: www.renesas.com/contact/

Corporate Headquarters

TOYOSU FORESIA, 3-2-24 Toyosu,
Keto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

© 2022 Renesas Electronics Corporation. All rights reserved.